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Tuesday 
June 28 2011 

Tuesday 
June14, 2011 

Monthly Meetings Held At Gould Auditorium 
2nd Floor, St. Joseph Community Center, Lorain, OH  

5:30 PM Doors Open With Q & A Sessions 
Meeting & Presentation Begins Between 7:00 & 7:15 PM 

NO Meeting  
 

Annual Picnic 
July 31, 2011 

French Creek Reservation 
Read  All About It on Page 6 

Open Source  
Software Alternatives 

 

Presented by  
 

Mike Zellers 
LCCC Professor 
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Don Hall 
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Web Page Editor 
Richard Barnett 
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Statutory Agent 
Sandra Ruth 
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Dennis Smith 
membership@lccug.com 
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Richard Barnett  
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Carole Doerr 
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Director of  

Education 

Kaye Coller 
education@lccug.com 

Why a smart phone 

 

Smartphones may be thought of as handheld computers inte-

grated with a mobile telephone.  While most feature phones 

are able to run applications based on platforms such 

as Java ME, a Smartphone allows the user to run and multi-

task applications that are native to that hardware. 

Smartphone's run complete operating system software provid-

ing a platform for application developers.  Thus, they com-

bine the functions of a camera phone and a personal digital 

assistant (PDA). 

 

Many people who haven’t used a Smartphone can’t imagine 

why they would want a computer that small to carry with 

them all the time.  They probably have a desktop computer or 

laptop and a ―regular‖ cell phone and don’t see why they 

would need anything more. 

 

While I don’t have a ―Smartphone‖ I encouraged my daughter 

to get one a few years ago when it was time for her to upgrade 

her phone.  Although, she was reluctant to pay the added data 

fees, now that she has had it for a while, she would be very 

reluctant to go back! 

 

I have had a cell phone for many years, but it has always been 

a pre-paid phone and has always suited me just fine.  My cell 

phone expenses seldom are more than $100 for the year.  I 

have it for convenience, to make a quick call to a business to 

see if they are open or if they have a product I want, to talk to 

family and for an emergency.  It has worked just fine. 

 

That is probably the main reason I haven’t moved to a 

Smartphone.  My gadget loving self would love to be able to 

do what a smart phone does.  But the expense, especially 

since my cell phone needs are so modest, cannot be justified.  

Yet! 

 

I have ―always‖ carried a palm PDA and know the usefulness 

of such a tool. As these many new mobile devices came 

along, the compromise that I have found for myself is an iPod 

touch. 

 

This is basically an iPhone without the cell phone service or 

the data service.  I just need to be in a Wi-Fi area to get the 

fun bells and whistles.  Therefore, when I am at home, at most 

friends homes, public library, a McDonalds or Wendy’s, etc.  

I can use the full features of the iPod touch. 

 

When I am in a Wi-Fi area, I can read my email, access all 

contacts, my Gmail calendar, Twitter, Facebook, any blogs I 

read, the news, weather, etc, etc, etc. 

 

Most all of my apps are free ones.  I have paid 99 cents to 

1.99 for a couple if I thought they were worth it.  The hard 

thing is not to want to try everything. There are over 350,000 

apps for the iPhone in the iTunes store. 

 

If I am not in a Wi-Fi area, I can still play almost all of the 

games I have downloaded, read dozens of books I have down-

loaded, listen to my whole collection of music, view all of my 

recent photos, watch a movie, check a recipe I saved, write a 

memo or to do list. 

   

I can always amuse myself for hours with this device – as 

long as the batteries hold out! 

 

When I am in Wi-Fi and can use the extra value tasks, I can 

appreciate how nice it would be to have those available to me 

ALL of the time.  But at this point, I am waiting for a better 

cost for the data plans to make that more affordable – justify 

that expense. 

 
Presidents Column (Continued on page 19) 

mailto:president@lccug.com
mailto:vp-programs@lccug.com
mailto:secretary@lccug.com
mailto:treasurer@lccug.com
mailto:newsletter@lccug.com
mailto:webpage@lccug.com
mailto:statutory_agent@lccug.com
mailto:membership@lccug.com
mailto:advertising@lccug.com
mailto:public_relations@lccug.com
mailto:education@lccug.com
http://en.wikipedia.org/wiki/Java_ME
http://en.wikipedia.org/wiki/Operating_system
http://en.wikipedia.org/wiki/Personal_digital_assistant
http://en.wikipedia.org/wiki/Personal_digital_assistant
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 COMPUTER REPAIR 

 PRINTERS & SUPPLIES 

 UPGRADES 

* CUSTOM PC'S & LAPTOPS 

* CALL FOR BEST PRICES 

* EDUCATION DISCOUNTS 

 LCD MONITORS & TVS 

365-2288 - Elyria  1-800-238-8973 - USA  
 

591 Cleveland Street   Elyria, Ohio  44035 

Shop at    www.ROYALBUSINESS.com    and save $$$ 
 

Financing Available  -  90 days same as cash 

TUESDAY 

June 14, 2011 

TUESDAY 

June 28, 2011 

 

No Meeting Tonight 
2nd Monthly Meetings are  

Cancelled for the Summer 

Open Source 
Software Alternatives 

 

Presented by  
 

Mike Zellers 
 LCCC Professor 

Professor Mike Zellers will describe exactly what open 
source means, how it is developed, and why this unlike-
ly process does work so well. He will also review some 
of the most common Open Source applications. 
 
"Open Source is where the source code which makes 
up the application is freely available to download, to 
distribute, to review," said Paul Holt of open source 
technology company Red Hat. 
 
"It's essentially developed by any number of organiza-
tions, individuals, or academic institutions. The ad-
vantages of it are numerous because there are many 
eyes on the code itself and it tends to be much better in 
terms of the quality of software - peer review etc." 
 
This should be a very interesting and enlightening even-
ing. 

L C C U G

READ ALL ABOUT IT!!!! 
 
Our 2nd meeting of the month is cancelled for the Sum-
mer.  The board thought that a lot of our members 
would be going on vacation or just wanting to spend 
summer time with their family friends, so only one meet-
ing a month until September. 
 
We have some exciting meetings coming up: 
 

√ July 12, Cloud Computing Updates by VP Lou 
Koch 

√ August 9, What’s in Your Hard Drive? Here are 
the A,B,C’s by member Neil Higgins 

√ September 13, Networking Your computers 
       By Lloyd & Carl from Discount Computer Parts 
 

So be there or be square…. 

http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.royalbusiness.com/
http://www.royalbusiness.com/
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.loraincounty.com/
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Executive Board  

Meeting Minutes 
General 

Meeting Minutes 

Computer Systems Unlimited, Inc.  
 

We are a full service computer/peripheral 
sales and repair Company specializing in 
custom built Pc's, network design, software 
integration, and everything in-between. We 
are located in the small college town of 
Oberlin, Ohio, and for fourteen years have 

been providing unrivaled service to home users, small and large busi-
nesses all over Ohio as well as State and local government  agen-
cies.  All of our systems and networks are tailored to meet the individ-
ual needs of our customers. 
 

Onsite service and repair for all networks and systems, In house 
service and repair, Pick up and drop off,  Printer repair and cleaning, 
Laptop repair, Software troubleshooting, Custom designed networks 
and pc's, MAC repair, Parts replacement & Expert advice and support 
and Data Recovery. 
 

* Computer Systems Unlimited is happy to offer a 5% discount 
on all computer systems ordered by LCCUG members.  
* Computer Systems Unlimited will also offer a free computer 
diagnostics check, (a $25 value), for all LCCUG members.  
 

Visit our web site at www.csuoberlin.com for more of what we can do. 

Store Hour Monday 9-5:30 - Thursday 9-5:30 - Friday 9-5 - Saturday 9-1  

MAY 5, 2011 
 

Attending were Sandee Ruth, Carole Doerr, Don Hall, 

Pam Rihel, Richard Barnett, Dennis Smith and Kaye 

Coller. 
 

The board discussed awarding certificates for years of 

membership. We will check with Lou Koch to see what 

records are available. 
 

The Q & A and tips will begin at 7 PM with the meeting 

to follow. 
 

Carole and Sandee will attend the APCUG conference. 
 

The 200 tickets have been sold, so the laptop computer 

drawing will be held at the May 10 the meeting. 
 

Kaye will have forms available for attendees at the next 

meeting requesting their wishes for future classes. 
 

Sandee will make inserts for the new program brochure 

listing the annual picnic and the APCUG conference. 
 

Dennis reported the computers/printers have been 

removed from the Senior Center and delivered to the 

recycle center. 
 

The June board meeting will be held May 31. 
 

Pam moved, Carole seconded the meeting be adjourned.  

MAY 10, 2011 
 

President Sandee Ruth called the meeting to order. A 

motion to accept the minutes as shown in the May issue 

of the INTERFACE was made by Ken Kohler, seconded 

by Neil Higgins. Motion passed. 
 

Sandee told attendees about Pam’s upcoming genealogy 

class and a beginner’s computer class at LCCC. 
 

Seaman John Larrison of the US Coast Guard Station in 

Lorain then talked about the two primary responsibili-

ties of the local station: Search & Rescue and Enforce-

ment. He told of the importance computers have in their 

encrypted Internet Messaging System. How they com-

municate between ship & shore and the adjacent stations

– Marble Head and Cleveland. There was an extensive 

question and answer period which he handled very well 

although limited due to security constraints. 
 

Carole Doerr won the money raffle, Carl Italiano won 

the first software/hardware raffle, Janis Mason won the 

Laptop raffle. 
 

Terry Deshon’s name was drawn for the attendance raf-

fle, however he was not present. 
 

Joe Harrold moved, Pam Rihel seconded the meeting be 

adjourned. 

http://www.csuoberlin.com/
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 Pam Rihel  LadyGeneo@roadrunner.com 

Important Information That Can Be 

Found On Religious  & State Docu-

ments: 
 

The document below is my grandma Ryan’s Baptismal Certif-

icate.  On this certificate, there is all kinds of great infor-

mation.  Make sure you read the whole certificate. 
 

Things to look for on a certificate: 

 Ancestor’s name/given name 

 Parent’s names 

 Mother’s maiden name 

 Place the Rite took place 

 Date of the event 

 Sponsors 

 Priest 

My grandmother’s given name was Mary Barbara, she always 

hated that name so she went by Marie. 

 

Next is my parents Marriage License, note the information on 

this  document: 

 

 State in which the marriage took place. 

 Groom’s name 

 Bride’s maiden name 

 Date of marriage 

 Witnesses 

 Pastor's name 

 Address where marriage took place, some licenses list the 

church’s name, this is the State issued license 

 

Check out all the  documents in your families  household to 

see if you can find anything you didn’t know and remember 

to make copies and to DOCUMENT where you found the 

information and  SOURCE in your family tree. 

Not All the information on documents are correct.  My moth-

ers birth certificate lists my grandmother maiden name as 

Schneider, when in fact it was Schuller.  

 

I think that where it asked to list mothers maiden name my 

grandmother thought they meant her mothers maiden name 

and so that is what she wrote in.  I found another copy of the 

same birth certificate and the mother’s maiden name had been 

corrected. 

mailto:LadyGeneo@roadrunner.com
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 
   

 
 

French Creek Reservation Metro Parks 
Pine Tree Picnic Area Shelter #1 

(off  French Creek Road) 
in Sheffield Village, Ohio 

July 31, 2011 
1:00 pm to 5pm 

 

The Picnic Committee will supply the hot dogs,   
hamburgers and the condiments. 

 

Your obligation is to bring a dish to share, your own place 
settings & your preferred drinks. 

 
 

We will have door prizes and games. 
 

You can sign - up  
at our  

June 14th Meeting 
 

We are in need of  volunteers to help set up and clean up 
after the picnic. 

 
Interested in volunteering email  

Carol Doerr at: public_relations@lccug.com  
or me, Pam Rihel at: newsletter@lccug.com 

 
Looking forward to seeing all our members there with their 

family and friends. 

mailto:public_relations@lccug.com
Pam%20Rihel


June 2011|  Interface Volume 23 Issue 6| Page  7 

NASA Plum Brook Tour 

April’s  tour of the Plum Brook Facility in Sandusky,  with 

many of our members and friends attending and enjoying the 

tour. 

 

Are you interested in taking more tours?   Just let  the officers 

know what facility you would like to tour and we will certain-

ly try to make it happen. 

 

Thanks to all who  came on this tour. 

L C C U G
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Free Credit Reports are 

Not Always Free 
How Can You Get a Copy of Your 

FREE Credit Report? 
 

You‘ve probably already heard by now that you are enti-
tled to a free copy of your credit report from each of the 
three credit reporting agencies. Locating a genuinely 
free credit report can take a bit of effort, as you‘ll see 
below. 
 

When Free Isn't Really Free 

On many websites where consumers are offered free 
credit reports, they are also simultaneously signing up 
for monthly credit monitoring services. After the first 
month, if the consumer doesn‘t want to continue with the 
service he or she will have to cancel or continue to be 
billed.  
 

The problem is that many consumer know that they are 
guaranteed a free credit report with no strings attached, 
but they fail to read the fine print after stumbling on a 
website that offers a free credit report in conjunction 
with signing up for a service that company offers. 
 

You Have a Friend In The FTC 

The Federal Trade Commission website is at 
www.ftc.gov. On their website, the FTC lists information 
about how consumers can obtain a copy of their free 
credit report. Annualcreditreport.com is a website that 
the FTC directs consumers to in order to get a free copy 
of their credit reports.  
 

Consumers can only get one copy of their credit report 
from each of the three agencies per year. Ultimately if 
you are ordering a free credit report from a website 
make sure you thoroughly read the terms and conditions 
before going any further to make sure that you aren‘t 
signing up for some service that you don‘t want. 
 

Your Report Is Not Your Score 

You may notice this free credit report is deficient of the 
well-known FICO score. The FICO score is a proprietary 
number calculated using formulas to determine your 
credit worthiness. The exact formulas are not available 
to the public.  
We live in the world of automation, and your FICO is 
used to determine everything about your credit history. 
For example, when you apply for a department store 
credit card, you get an instant credit decision on your 
credit. This instanteous decision is based upon on a 
quick look at your FICO score. 
 

To get your FICO score, you need to pay money on a 

website like www.myfico.com. However, your free credit 
report will in most cases be good enough. Instead of 
paying money to find your exact FICO score, just use 
your free credit report to view or repair your credit.  
 

A General Clue 
Although the exact FICO recipe is hidden from the pub-
lic, looking at your free credit report will give you a rough 
estimate of your score. FICO score improve over time 
with established credit and no delinquencies of 30 days. 
Deliquesce of 60 days or greater cause even more dam-
age. Too many high balances relative to your credit limit 
causes your score to drop. Order a copy of your free 
credit report and take a closer look at your credit history 
to see where you can make improvements.  
 

Copyright Audri and Jim Lanford.  All rights reserved. 
Reprinted with permission.  Subscribe free to Internet 

ScamBusters at http//www.scambusters.org 

 

 

 

Copy An Entire Excel Worksheet 
 

It‘s easy to copy data from one worksheet to another, 
but if you have reformatted the width and height of col-
umns or added headers and footers, you should copy 
the entire worksheet to avoid making those changes on 
your second worksheet. To copy and paste everything, 
press and hold the CTRL key, click the tab of the work-
sheet you want to copy, and then drag it to worksheet  
tab where you want to paste the data.  

 
Keep Up With Updates 
 

Many types of viruses and malware use known vulnera-
bilities in Microsoft's Windows operating system to find a 
loophole into your computer. Typically, the Windows 
Update patches fix the known issues and help keep 
your PC secure. If you don‘t want to Windows to auto-
matically update, at least configure Windows Update to 
notify you of the latest patches, so you can check out if 
there are any security updates that may be needed to fix  
holes in Windows.  
 

Customize Windows Explorer 
 

The toolbar of Windows Explorer offers a few quick nav-
igation tools, but you can also add button to the Explorer 
toolbar to make it easier to access the options you use 
most often. To add features to the Toolbar, right-click it 
and select Customize. Under the Available Toolbar But-
tons heading, you‘ll see a list of items you can add. Se-
lect the items and then click the Add button.  
Error! Hyperlink reference not valid. 
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

http://www.scambusters.org/
http/www.scambusters.org
http://www.smartcomputing.com/
http://www.smartcomputing.com


June 2011|  Interface Volume 23 Issue 6| Page  9 

On Site or Walk In Services  

440-322-0259 
210 East Second St., Elyria 44035 

New Systems Upgrades 

Diagnostics Installations 

Virus Removal System Tune Ups 

Rebuilt Systems 

You may want to insert tomorrow‘s date into a cell 
in your worksheet. This is easily done by simply 
creating a formula that includes the function for to-
day‘s date, as in the following: 

 
This formula first determines today‘s date and then 
adds 1 to it, resulting in tomorrow‘s date. You can 
then use Excel‘s formatting features to display the 
resulting date in any manner desired. 

Besides displaying tomorrow‘s date, you can modi-
fy the formula to display a date at any time in the 
future. Simply change the formula so the desired 
number of days are being added to today‘s date. 
For instance, if you wanted to determine a date two 
weeks in the future, you could use the following: 

 
 
Copyright © 2011 by Sharon Parq Associates, Inc. Re-
printed by permission. Thousands of free Microsoft Ex-
cel tips can be found online at http://excel.tips.net. 

=TODAY() + 1 

=TODAY() + 14 

Inserting the Date  

and Time 

Inserting Tomorrow’s 

Date 

Undoubtedly, the time will arise when you need to 
insert the current date or time in your document. 
This may be in the introduction of a letter or in a 
header or footer. Word allows you to quickly insert 
the date or time in several different formats. This 
information is inserted as a field which can be up-
dated manually or is updated automatically when 
you print the document. 
 
To insert the date or time into your document, fol-
low these steps: 

1. Position the insertion point where you 
want the date or time inserted. 

2. Display the Insert tab of the ribbon. 
3. Click Date & Time in the Text group. Word 

displays the Date and Time dialog box. 

The Date and Time dialog box. 

 
4. Select a format for the date or time. 
5. Select the check box at the bottom of the 

dialog box if you want the selected date or 
time to always reflect whatever is current. 
If you choose this, it means that Word in-
serts the date or time as a field so that it 
always represents the current date or 
time. 

6. Click on OK. The date or time, as speci-
fied, is inserted in your document. 

 
Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Word tips can be 
found online at http://word.tips.net. 

http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com/
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://excel.tips.net
http://excel.tips.net/
http://word.tips.net
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LCCUG O NGOING  CLASSES  
AND  WORKSHOPS  

 ALL  ARE  FREE  AND  OPEN  TO  THE  P UBLIC  

 

  Date:  Tuesday June 21, 2011 
  Time:  5:30 - 8 pm  Instructor:  Micky Knickman, et al. 

  Place:  Amherst Church of the Nazarene 
   210 Cooper Foster Park Rd.,44001 

 

 

   Learn how to repair or update your computer by changing 
hard drives, memory, CD ROMs, etc. 
 Members are encouraged to bring their computers any-
time before 7:30 pm for assistance from Micky, Neil or other 
knowledgeable members.  

Problem Solving Workshop 

NEED HELP?— 
Here‘s Who to Contact: 

 
Neil Higgins 
  

 440-967-9061 - higgins.neil@gmail.com 
 Evenings 6 p.m. -10 p.m. + Weekends 
  Hardware, Linux & Windows Operating Systems,  
 Tweaking your system 

 

Micky Knickman 
     

 440-967-3118 - micky@knickman.com 
  Evenings 5 p.m. – 8 p.m. + Weekends 
   General Software Configuration, Hardware Installation,  
 Basic to Advanced Windows 
 

Lou Koch 
    

 440-985-1585 - lkkoch@centurytel.net 
   Microsoft Office: Excel, Word, PowerPoint, Publisher, Access, & 
 Outlook, Basic to Advanced Windows 
 

Edie Lewandowski 
    

 440-282-4188 - elew@erienet.net 
   Daytime - midnight 
   Desktop Publishing, General File Management, Eudora Email, 
 MSWorks Tools,  
 

 Richard Barnett 
      

 440-365-9442 - Richard216@aol.com 
    Evenings & Weekends 
   General Software Configuration, HardwareInstallation, Basic to 
 Advanced Windows & Web Page Design 

 

Sandee Ruth  
   

 440-984-2692 - sandee29@gmail.com 
  6 p.m. - 10 p.m. except when at work 
   Basic Word Processing, Windows,  & Web Design 

   Advanced Internet  
 

Jeff Kasler 
    

 440-967-7142 - Jeffk@roadrunner.com  
   10 a.m. - 7 p.m. 

   Burning CDs using Record Now  
 

David Kennett 
    

 440-327-8624 - w8kfj@yahoo.com 
 9 a.m. - 8 p.m.   
 Video Editing & DVD Burning 
 

Cathy Ratcliff 

 

 therats1@verizon.net 
 Though she lives in Coshocton, you can call  
 740-327-1483  before 8 pm 
 Paint Shop Pro, other Photo Editing programs, 
 Microsoft Office programs  
 
Keith Kuhn 
    

 440-967-6509 - kthkuhn@yahoo.com 
 8 a.m. - 11 p.m.   
 Downloading Music & Burning CDs 

Don’t forget to check the Members’ page for up-to-date infor-

mation about programs & events: 

http://www.lccug.com/members 

Date: is Cancelled until September 
Time:  
Instructor:  Pam Rihel 
Place:  LCCC Learning Center. 
  St. Joe‘s Com. Center,  21st & Broadway 

  

 Learn more about finding your ancestors with public rec-
ords & online websites.  How to start & sources to use. 
 

You must register   -  Phone: 440-277-6076  or 
Email: LadyGeneo@roadrunner.com 

Genealogy Class 

Date:  Cancelled for June 
Time: 3:00 - 5:00 pm 
Instructor:  Jean Griffith 
Place:  LCCC Learning Center. 
  St. Joe‘s Com. Center,  21st & Broadway 
 

Bring your questions if you‘d like.  Jean will start with the 
basics and move on to intermediate topics if time allows. 
Learn MS Word, copying & pasting, for-matting text, saving 
files, basic file management, basic PC maintenance, etc 

 

Register by calling LCCC Learning Center:    
440-366-4507 

Beginning to Intermediate 

 Computing 

LCCUG Treasurer's Report 
3/29 Beginning balance  $   9,496.75  

  membership dues  $      225.00  

  Raffle proceeds after purchases  $      279.16  

  Sponsorships & Ads  $      310.70  

  Interest earned  $       47.17  

  Meeting expenses for presenters  $     (126.00) 

  Membership printing & supplies  $      (39.12) 

5/28 LCCUG Certificate of Deposit  $   5,000.00  

5/28 General Fund balance  $   5,193.66  

mailto:higgins.neil@gmail.com
mailto:micky@knickman.com
mailto:lkkoch@centurytel.net
mailto:elew@erienet.net
mailto:Richard216@aol.com
mailto:sandee29@gmail.com
mailto:Jeffk@roadrunner.com
mailto:w8kfj@yahoo.com
mailto:therats1@verizon.net
mailto:kthkuhn@yahoo.com
http://www.lccug.com/members
mailto:LadyGeneo@roadrunner.com
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June 2011 Classes 

Class Type Location Registration June Time More Info 

Classes / Workshops 

Problem Solving 
Micky Knickman 

Amherst Church of 
the Nazarene 
210 Cooper Foster 
Park 

  
Not Required 

June 21, 2011 
5:30 to 8:00 

pm 
Page 10  

Genealogy Class 
Online & Off 
Pam Rihel 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Reg. required  
 

LadyGeneo @ 
roadrunner.com 

Cancelled until 
September 

 3:00-5:00 pm Page 10 

Beginning to Inter-
mediate Computing 
Class 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Jean Griffith 
 

Register by call-
ing:    

440-366-4507 

Cancelled for 
June 

 3:00-5:00 pm Page 10 

Is there a class you would like to teach or a class you would be interested in attending, please let one of our 
officers know. 

We want to fill this last row with something new to be taught.  

The Lorain County Chapter of OGS 
is having it‘s next  meeting on : 

 

June 13th, “The Importance of Staying Or-
ganized”  Presented by Debra Abbott, 

PhD, she will discuss inexpensive ways to create file 
systems, materials needed, genealogy software and 
other items that will keep your genealogy neat and un-
der control.  The use of descendants' charts, spread 
sheets, research logs and other forms will also be dis-
cussed 
 

Meetings are held the 2nd Monday of the month in the 
North Ridgeville Library on Bainbridge Rd., east off Rt. 
83-just south of Rt. 20.   
 

Meetings start at: 7:00 PM for the program, with Social 
time at 6:30 PM;    Meetings are free and open to the 
public. 
 

Come and enjoy some interesting genealogy pro-
grams. 

For direction's to North Ridgeville Library follow this 
link. 

 

http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-
82.014903&zoom=16&q1=35700%20Bainbridge%

20Road%20North%20Ridgeville%2C%20OH%
2044039 

Ohio Computer Repair Service 
47375 Cooper Foster Park Road 

Amherst, Ohio 44001 
(440) 984-5265 

 

The Problem: 

Computers can be fun and frustrating at the same time. 
This may be a surprise to some, but 90% of everything that goes 
wrong with a computer is configuration related. The problem is, 

there are just too many settings to change and modify, and most 
people don't even know where these settings are.  

The Answer: 
You could read and study like I did for the last 14 years. You 

could experiment with your computers on a daily basis until you 
get it right, or search the Internet and find more sites than any 

ten people could read in a lifetime. You could accidentally break 
your computer more times than you care to remember, or you 

can call us, Ohio Computer Repair Service.  

The Result: 
A computer that runs all the time with no errors, no surprises, 

and does it faster and better than when it was brand new. 

Newsletter Editor:  Pam Rihel using Microsoft Publisher, Corel 
Paint Shop Pro X3, CreataCard 8.  

 

This Month’s contributors: Micky Knickman, Sandra Ruth, Kaye 
Coller, Pam Rihel, Carole Doerr, Don Hall, Art Gresham, APCUG, 
Wordtips.net, Exceltips.net, Smart Computing Magazine, Microsoft 
Office art online, PC Computer Magazine, CPU, 
 

Newsletter is now 
Online 

at 
lccug.com/newsletters or lccug.com 

mailto:LadyGeneo@roadrunner.com
mailto:LadyGeneo@roadrunner.com
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://www.wordtips.net
http://www.exceltips.net
http://www.lccug.com/newsletters
http://www.lccug.com
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7 Little Word Annoyances 
and Their Easy Fixes 
 

By Nancy DeMarte, Columnist, Office Talk, 
Sarasota PCUG, Inc., FL  
March 2011 issue, Sarasota PC Monitor 
www.spcug.org 
ndemarte (at) Verizon.net 
 

Below is a collection of frustrating things that can hap-
pen when using Microsoft Word. These annoyances can 
occur in any version of Word although most are geared 
to Word 2007 and 2010. In Word 2003, the fix-it steps 
may be different. 
 
Annoyance 1 -- You accidentally press the Caps Lock 
key on your keyboard before typing a paragraph. When 
you finish, you find everything in capital letters. 
 
The Fix: Rather than retyping the whole paragraph, 
highlight the text, then click the "Change Case" button 
(Aa), located on the Home tab in the Font group. Click 
"Sentence case" to transform your paragraph into nor-
mal sentences.  
 
Annoyance 2 -- You create a party invitation with a light 
blue background (Page Layout tab - Page Color). But 
when you print it, the background is white. 
 
The Fix: Office has set Word to not print full page back-
ground colors, probably to save users from wasting ink. 
You can, however, make the colored background print. 
Click the Office button, then Word Options -- Display. 
Put a check mark next to "Print background colors and 
images," then click OK. Until you remove this 
checkmark, all colored backgrounds will print. 
 
Annoyance 3 -- You're working on a document where 
you've set the text size to be a fairly small 10 points. But 
you find that the text is too small to view comfortably 
while you're typing. 
 
The Fix: Drag the Zoom slider located in the bottom 
right corner of the Word window to the right to enlarge 
the screen view of the text. When printed, the text will 
be 10 points no matter how big it appears on the screen.  
 
Annoyance 4 -- You find that the spaces between lines 
of text in your document are wider than you want.  
 
The Fix: If all the spaces are wider than expected, you 
can change the line spacing for the whole document at 
once. On the Home tab, in the Editing group, click Se-

lect -- All to highlight all the text. Next click the Line 
Spacing button in the Paragraph group and select 1.0 
for single-spacing or one of the other choices. 
Note: Word will not remove extra space after para-
graphs when you choose a line spacing size. To remove 
extra space after a paragraph, select the paragraph be-
fore the extra space, click the Line Spacing button and 
choose "Remove Space After Paragraph." A more per-
manent way to create no extra space between para-
graphs is to open the Paragraph group dialog box 
launcher (small diagonal arrow) on the Home tab and 
put a checkmark in front of "Don't add space between 
paragraphs of the same style." 
 
Annoyance 5 -- Every time you type an email or web 
address into a document, it turns into a clickable hyper-
link with underlined blue text, even if that isn't your in-
tention. 
 
The Fix: The quickest fix is to right click the address 
and select "Remove Hyperlink." But this is only a one 
time remedy. To remove this action permanently, click 
the Windows button, then this sequence: Word Options 
-- Proofing -- AutoCorrect Options -- AutoFormat As You 
Type. Remove the checkmark next to "Internet and Net-
work paths with hyperlinks" and click OK. 
 
Annoyance 6 -- You find that as you type, distracting 
wavy red and green lines show up under words and 
phrases.  
 
The Fix: Word is set to check spelling (red lines) and 
grammar (green lines) as you type. This is another 
Proofing option which comes enabled from the factory. 
To turn off one or both of these features, go to Word 
Options (Office button - Word Options) and click Proof-
ing. Remove the checkmarks next to "Mark grammar 
errors as you type" and "Check spelling as you type." 
You can always check spelling and grammar after your 
document is complete by clicking Spelling & Grammar  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on page 13) 
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at the left end of the Review tab. 
 
Several of these fixes involve the settings found in the 
Options area of the Office 2007 menu (File menu in 
2010). Options are available for all the Office programs 
(Word Options, Excel Options, Access Options, etc.) 
These default settings were determined by interviews 
with thousands of people who use Office regularly in the 
workplace. If you find that the factory settings are caus-
ing you more trouble than help, changing them is a sim-
ple task. All Office users should take a personal tour of 
the Options menus, which resemble this Word Options 
window with the AutoCorrect box open: 
 
Annoyance 7 -- You often save documents to the same 
folder which is buried within other folders in My Docu-
ments. It takes several clicks to find this folder each time 
you want to open or save a document to it. 
 
Fix 1: You can find almost any folder on your Windows 
Vista or 7 computer by typing its name into the Start 
Menu search box just above the Start button. Often it 
takes only a letter or two before the folder appears in 
the search results. On the downside, you have to do this 
each time you want to open the folder. 
 
Fix 2: A way to make any folder immediately available is 
to add it to the Favorites section of the navigation pane. 
This pane appears on the left side of any explorer win-
dow where you are viewing, opening or saving files and 
folders. To make a folder a Favorite, start by creating or 
opening a file, like a document, and click Save As, 
which opens the Save As dialog box. This reveals the 
navigation pane on the left, showing a list of possible 
places to save the file. Navigate to the folder you want 
to make a favorite so that it is the last item in the history 
bar across the top. Then right click the word Favorites in 
the left pane. From the drop down menu, click "Add cur-
rent location to Favorites." Your special folder will now 
appear in the Favorites list. It will also appear in the Fa-
vorites list of the other MS Office programs on your 
computer, such as Excel and PowerPoint. To remove a 
folder from Favorites, right click the folder and select 
Remove. 
 
Using a computer should be fun as well as useful. Take 
a few minutes to think what your personal computer an-
noyances are and try to find fixes for them. Customizing 
your programs makes using the computer much more 
enjoyable and efficient.  
 
There is no restriction against any non-profit group using this article as 
long as it is kept in context with proper credit given the author. The 
Editorial Committee of the Association of Personal Computer User 
Groups (APCUG), an international organization of which this group is 
a member, brings this article to you. 

(Continued from page 12) 7 Little Annoyances… 
 

Windows Vista and 7: Copy as 

Path 

 

Everyone knows that right-clicking on a file or a folder 
usually brings up a menu with basic choices, like ―Open‖ 
or ―Copy‖. For those that crave a little more out of their 
right-clicks, however, might I suggest holding the Shift 
key when you right click? In Windows Vista and 7 the 
usual menu that pops up will now include an option 
called ―Copy as Path‖. This actually copies the entire 
path of the file or folder to your clipboard, and allows 
you to paste it wherever you want. 
 

 
 

This is useful for when you‘ve located a file in Explorer 
and you want to upload it to a Web site. So, instead of 
taking the time to browse for the file on the site, you can 
just copy and paste its path directly. 
 
Pretty neat, if I do say so myself! 
~Andrew 
 

Pin Thumbnails in Google 

Chrome 

 

So, if you‘re a Google Chrome user, then you‘ve proba-
bly seen the nifty dashboard screen at one time or an-
other. Among other options, it‘s a place that shows you 
your most visited sites in thumbnails form for quick an 
easy access. 

That being said, those thumbnails tend to shift around a 
bit as your browsing habits change. If you want to keep 
one up there permanently, though, it‘s pretty easy. Just 
hold your mouse pointer over the thumbnail you want to 
keep and click the little pin icon. 
 

Reprinted with permission from WorldStart.  Visit 

http://www.worldstart.com and subscribe to their 

informative newsletters. 

http://www.worldstart.com/
http://www.worldstart.com
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Tell-tale Signs  
of a Fake Blog 
 

It's commonly known as a "flog" -- a fake blog -- and the 
con-artists who run them and bogus news sites are cur-
rently raking in an estimated $750 million a year selling 
products of questionable value, from supposed miracle 
cures to phony anti-virus software. 
 

They're easy to set up and, even though the Federal 
Trade Commission (FTC) recently filed lawsuits to try to 
stop some of them, the tricksters often skirt their way 
around the law to stay in business. 
 

What's a fake blog? Well, first, let's think about what a 
blog is: it's usually a personal or company website that's 
regularly updated with the latest news, views, and com-
ments. 
 

People use them to promote their products, air opinions 
and, sometimes, just to think out loud about the issues 
that interest or affect them. 
 

But when a blog pretends to be something other than 
what it really is, that's what we mean by a fake blog. 
 

Sometimes they only have one article, often posing as 
an impartial news report commenting on some kind of 
"miracle" product. 
 

We reported on this bogus "news" activity in one of our 
earlier issues. 
 

http://clicks.aweber.com/y/ct/?
l=5pX.p&m=1ZI_F9XrpGtWfo&b=HTsAlF_zXmcqycDV
W4TfLQ 
 

One of the earliest and most notorious examples of a 
phony blog, a few years back, was a running account by 
an individual of his journey across the United States 
visiting stores owned by one of the nation's biggest re-
tailers. 
 

It's not that the reports were false. But red faces glowed 
all-round when the blog was exposed as a marketing 
trick, secretly paid for by the retailer (or at least its PR 
company) and written by a professional journalist. 
 

Even though he really did make the trip, the blog itself 
was held to be deceptive because the true purpose and 
funding were not disclosed. 
 

You might consider that harmless, but in recent years 
the fake blog has taken on a more sinister guise, fre-
quently used by individuals to lure consumers into 
spending their money on "miracle" products. 
 

Just to be clear, it's not illegal to make claims about a 

product's supposed wondrous properties -- subject to 
following certain rules. 
 

The trouble starts when bogus bloggers pass them-
selves off as interested but impartial reporters and con-
sumers who just happen to have tried the product and 
supposedly found it worked... like a miracle. 
 

And this doesn't just happen with a fake blog. Some-
times, the sellers of these questionable products pop up 
as commenters on legitimate blogs, promoting their 
products or services. 
 

In other cases, companies have been known to pay indi-
viduals to pretend to be satisfied customers, posting 
positive comments in blogs. 
 

The FTC already has guidelines against this practice. Its 
Ad Practices director Mary Engle says: "An ad disguised 
as a blog or a blog where companies get people to pose 
as satisfied customers and write reviews, both are de-
ceptive." 
 

Then in April 2011, the FTC filed its lawsuits to shut 
down fake news sites pretending to report independent-
ly on acai berry supplements, when, in fact, they were 
entirely fabricated. 
 

Although all different, most of the sites carried the same 
report about the supposed effectiveness of the products, 
attributed to a journalist whose photo was used or with 
exactly the same comments from a purchaser using dif-
ferent names. The FTC alleged that none of these were 
genuine. 
 

More Fake Blog Tricks 
One particularly sneaky trick is for phony blogs to pose 
the question -- either in the main text or in a comment – 
asking something like: "Is such-and-such a product a 
scam?" 
 

Someone always answers to the effect that, of course 
it's not a scam. They claim they tried it and it works. Oh 
really? 
 

Then, whenever someone like you or us does a legiti-
mate Internet search to check out the product by asking 
the same question, chances are they'll be directed to the 
fake blog site, just because they used the same words. 
 

In yet another variation, people set up scores of fake 
blog sites using mixtures of frequently searched-for 
phrases, strung together into paragraphs. 
 

Sometimes the words make sense, sometimes they 
don't. But they'll probably have nothing to do with the 
subject you're searching on and, if you land there, you'll 
find a page plastered with advertisements. 
 

Again, this is not illegal, but let‘s face it, it's highly mis-

(Continued on page 15) 

http://www.scambusters.org/
http://clicks.aweber.com/y/ct/?l=5pX.p&m=1ZI_F9XrpGtWfo&b=HTsAlF_zXmcqycDVW4TfLQ
http://clicks.aweber.com/y/ct/?l=5pX.p&m=1ZI_F9XrpGtWfo&b=HTsAlF_zXmcqycDVW4TfLQ
http://clicks.aweber.com/y/ct/?l=5pX.p&m=1ZI_F9XrpGtWfo&b=HTsAlF_zXmcqycDVW4TfLQ
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Internet Explorer 10  
Under Development 
 

The paint may barely be dry on Internet Explorer 9, but Mi-

crosoft’s already begun work on the browser’s successor. 

The company released the initial test version of Internet Ex-

plorer 10—dubbed ―Platform Preview 1‖—and plans to is-

sue updated versions about every 12 weeks. 
  

The IE10 Platform Preview is intended for developers, but if 

you’re feeling curious—and brave—you can download it at 

ie.microsoft.com/test-drive. The preview version of IE10 is 

compatible with several Web standards not supported by 

IE9, and it requires Windows 7. 

 

Microsoft Office 365 Enters Public 
Beta 
 

Microsoft has launched a public beta of its upcoming Office 

365 Web-based subscription service. Office 365 offers 

online access to browser-based versions of Microsoft 

productivity applications Word, Excel, PowerPoint and One-

Note, as well as other Microsoft communication and collab-

oration products such as Exchange for email and calendar, 

SharePoint Online for document sharing, and Lync Online 

for instant messaging and videoconferencing. 
 

When Office 365 beta program ends, subscription pricing 

for Plan P1—intended for professionals and small business-

es—will start at $6 per user per month.  For more infor-

mation or to sign up for the Office 365 beta, visit ti-

nyurl.com/3sgal4. 

 
Reprinted with permission from Smart Computing.  Visit 

http://www.smartcomputing.com to learn what Smart Computing can 
do for you and your user group! 

leading, and a dubious marketing practice. 
 

One activity that has been outlawed by the FTC is when 
genuine bloggers accept a payment to promote a partic-
ular product without telling readers. They're now obliged 
to disclose the payment, even if it's payment-in-kind. 
 

As if all that's not bad enough, some varieties of fake 
blogs trick people into believing their PCs are infected 
with a virus. 
 

Again, you might arrive there through a search engine, 
like Google or Yahoo, because they contain the words 
you're looking for, but when you get there, a window 
pops up saying your PC is infected and offering to re-
move the virus -- for a fee. 
 

If anyone is naive enough to click on one of these pop-
ups, the crooks will not only take their money but also 
upload malware to the PC to steal information. 
 

Read more about this type of scareware in our earlier 
report. 
 

http://clicks.aweber.com/y/ct/?
l=5pX.p&m=1ZI_F9XrpGtWfo&b=FlXGd.hO0j3I21o13dx
W0Q 
 

Is it a Fake Blog Site? 
So, how can you tell if you're visiting a fake blog site or 
reading a phony comment? 
 

Well, unfortunately there's no foolproof way to detect 
them.  But there are some telltale signs you can be on 
the look-out for: 
 

* Personalized ads that appear on legitimate websites, 
often suggesting someone in your area (which is easy 
for the scammers to identify) has discovered or tested a 
miracle product. The ads usually lead to a site promot-
ing that product. 
 

When you get there, it may appear as an individual's 
personal blog but the chances are it's not. 
 

* The "blog" only has one story, with a recent date, dis-
cussing a particular product or service. 
 

* Many use one of the common blog programs -- like 
Wordpress, Blogger, and Typepad. Although pages are 
customizable, fake blog operators usually don't bother, 
so they're rather plain in appearance. 
 

* Someone (a commenter or the "blogger") asks if the 
product is a scam and then the claim is rebutted. 
 

* The site has no contact information other than links or 
ads to the product it promotes. It usually had no ads for 
other products. 
 

* It contains jumbled text that doesn't make sense. 
 

* The comments include sensational claims, such as "it 

(Continued from page 14) Tell Tale Signs of a Fake Blog changed my life." 
 

* Phony comments, even on real sites, often give them-
selves away by including links to other websites or hav-
ing a poster's name (which may be clickable) that's ei-
ther a blatant promo -- like "miracle_weight_loss" or a 
single first name followed by a number, like "Jon123." 
 

Of course, you should never click on a pop-up that 
claims your PC is infected with a virus. If this happens, 
exit your browser and run a scan using your own securi-
ty software. You do have it installed and updated don't 
you? 
 

We always encourage our readers to be skeptical and 

cautious about anything they read on the Internet. When 

it comes to the risk of encountering a fake blog, you 

should double your guard! 
 

Copyright Audri and Jim Lanford.  All rights reserved. 
Reprinted with permission.  Subscribe free to Internet 

ScamBusters at http//www.scambusters.org 

http://www.smartcomputing.com/
http://www.smartcomputing.com
http://clicks.aweber.com/y/ct/?l=5pX.p&m=1ZI_F9XrpGtWfo&b=FlXGd.hO0j3I21o13dxW0Q
http://clicks.aweber.com/y/ct/?l=5pX.p&m=1ZI_F9XrpGtWfo&b=FlXGd.hO0j3I21o13dxW0Q
http://clicks.aweber.com/y/ct/?l=5pX.p&m=1ZI_F9XrpGtWfo&b=FlXGd.hO0j3I21o13dxW0Q
http/www.scambusters.org
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Window’s News & Tips 
 

Problem Steps Recorder 
 
When you need help solving a computer problem, the best 

approach is to allow remote access to someone knowledgea-

ble so he or she can directly see, and if necessary, control 

your system. 

But remote access isn’t always an option, and when it’s not 

possible or practical, the next best thing is to provide your 

helper with detailed information about what you’re doing 

when the problem occurs. As it turns out, there’s a little-

known utility built into Win7 called Problem Steps Recorder 

that makes obtaining such troubleshooting info pretty simple. 
 

To launch Problem Steps Recorder, click Start, type steps in 

the Search box, and then select Record Steps to Reproduce a 

Problem. The Problem Steps Recorder utility will appear. 

Before performing whatever actions lead to your problem, 

click the Start Record button. The utility will now keep track 

of everything you do, including where you click, what you 

type, and which programs you open; capture a screen shot for 

each step; and collect some additional background technical 

data regarding any error messages encountered. 
 

When you click Stop Record, you’ll be prompted to name the 

recording, which will be saved with a .ZIP file extension. To 

see what was recorded, open the file and run the MHT file 

within (which will open in your browser). 
 

To send the recording to a helper, click the down arrow on the 

right and select Send To E-mail Recipient; your email pro-

gram will automatically open with the recording file attached.  

(If you use Web-based email such as Gmail or Hotmail, you 

may need to attach and send the file manually.) 
 

Password-Protect Microsoft Office Files 

If you have a Microsoft Office file that contains sensitive in-

formation, you can guard against unauthorized access by en-

crypting the file with a password. 
 

To password-protect an Office 2007 (Word, Excel, or Power-

Point) file, open the file and click the Office button. Next, 

choose Prepare, select Encrypt Document, enter your chosen 

password, and then type it again. Going forward, the pass-

word will be required to open the file. (The password can be 

up to 255 characters but be sure not to forget it because 

there’s no password retrieval option.) To remove the pass-

word from a file, repeat the process, except clear the pass-

word box and then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Access to the password encryption settings is slightly differ-

ent in Office 2010. Click File, Info, Protect Document, and 

Encrypt With Password. 
 

Arrange Windows on Your Desktop 

For a quick way to arrange your open windows so that they’re 

all visible but not overlapping, right-click an empty area of 

the Taskbar and select Show Windows Stacked or Show Win-

dows Side By Side. To return the windows to their previous 

orientations, right-click the Taskbar again and choose the 

appropriate Undo option. 

 

Microsoft has already started work on Internet Explorer 10. 
 

You can learn more about the new Internet Explorer 9 at  

www.beautyoftheweb.com 
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

Problem Steps Recorder can help with trouble-
shooting by creating a detailed record of activities 

To Protect a sensitive Word, Excel  
or PowerPoint file, encrypt it with a password. 

This goes in the top story. 

http://www.smartcomputing.com/
http://www.beautyoftheweb.com
http://www.smartcomputing.com
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Windows XP Run  

Commands 
 

Skip the navigating and just type in what you‘re looking 
for! Windows Vista and 7 users can do this already, but 
if you‘re still using Windows XP, these commands might 
come in handy! 
 

 

Just click Start>Run, type one of these commands in 
the box and hit OK. 
 

Calc – Calculator 
Charmap – Character Map (for special characters) 
Cleanmgr – Disk Cleanup 
Clipbrd – Windows clipboard viewer 
Control – Displays the Control Panel 
Netstat – Displays all active network connections 
Regedit – Registry Editor 
Taskmgr – Task manager 
 
Give ‗em a try today! 
 

~Andrew 
 

Reprinted with permission from WorldStart.  Visit 

http://www.worldstart.com and subscribe to their 

informative newsletters. 

 

Cleveland Ohio—right in our own backyard! 
 

This year the APCUG Annual Meeting & Confer-

ence will be at the Crowne Plaza in Independence, 

Ohio, just 30 miles from our usual meeting place. 
 

The conference will start with a sign in and regis-

tration on Friday afternoon, July 15th at approxi-

mately 3:00 PM EDT and will be followed by a 

meet & greet in the lounge. The attendance fee for 

the conference is $65. This will cover the Friday 

night meet & greet, a full day of workshop ses-

sions on Saturday & a half-day on Sunday.  
 

The final conference schedule is being worked out, 

but some of the currently booked workshops and 

general sessions will include: 
 

 Virtual Machines 

  MAR's Refurbishing & Recycling 

  iPad features along with using iPad for e-

books 

 Windows Tips & Techniques 

 The Linux Guy 

 Linux and the future of computers 

 Safe data destruction 

 Ins and Outs of Skype 

 Fundraising 

 OneNote 

 Q&A sessions with the Boards of Directors & 

Advisors 
 

For the full schedule::   http://cleveland.apcug.org/

schedule.htm  

Hope to see you there!!! 

Genealogy Websites: 
Free genealogy and family tree search tips, how to articles 

and on-line genealogy tutorials 
http://amberskyline.com/treasuremaps/ 

 

"Who Else Wants to know how to Build a Family Tree that 

will amaze Family Members and Friends... and do it the easi-

est way?" 

http://genealogytipsandtricks.com/ 

 

Free genealogy websites: 

a how-to guide for using online resources and public records 
http://www.your-family-tree.com/free_genealogy_websites.htm 

http://www.worldstart.com
http://www.worldstart.com/
http://cleveland.apcug.org/schedule.htm
http://cleveland.apcug.org/schedule.htm
http://amberskyline.com/treasuremaps/
http://genealogytipsandtricks.com/
http://www.your-family-tree.com/free_genealogy_websites.htm
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Keeping it all in “Sync”- a 
Sweet Synchronization Idea 
 
By Art Gresham, Editor, UCHUG (Under the Computer 
Hood User Group), California 
March 2011 issue, UCHUG Drive Light 
www.uchug.org 
1editor101 (at) uchug.org 
 
At the February 2nd, 2011 meeting of the UCHUG dur-
ing our discussions about Computer Health, I talked 
about how to automate some of the processes that can 
keep your system running well. I mentioned that I had 
long been searching for a way to keep my passwords 
safe, while still being able to access them from comput-
ers at different locations. The program I use on my pri-
mary home desktop system is called AnyPassword 
(v1.44). It keeps the information in  an encrypted, pass-
word protected file, but if I want the current updated 
copy on my system at work I have to email or transfer it 
by some other means manually each time I want it re-
freshed. I know there are other programs that do a good 
job of handling your passwords, and some for very mini-
mal cost, but I like AnyPassword and only needed a way 
to solve this synchronization problem. 
 
I believe I have found a simple, and free way to handle 
this, and any similar file-sync or sharing problems. The 
Cloud service I am using is called SugarSync. It is free 
and has a large space allocation (5 GB) that suits my 
needs. I have placed the data file  for my password pro-
gram in the folder that I setup for sharing. 

I opened the AnyPassWord program with my laptop. 
There I showed the basic structure of the password pro-
gram, and opened a sample key (this is a game-site, not 

any critical data here). I made a simple change to the 
free text comment section. I then clicked save.   
 
I explained that within a few moments that this very file, 
with the change, would be resident on my desktop com-
puter (named ‘Dakota‘) at home, which I had running 
before coming to the meeting. 
 
So as soon as I got home I opened the password pro-
gram, and went to that key. The result is shown here. As 
you can see the comment section has the text 'note 
from the uchug meeting.‘ This was the text I typed in at 
the meeting, and without any physical action on my part 
the data 'magically' is present on the hard drive, in my 
shared folder on Dakota. 

You can set up an account for yourself and get the free 
5 GB of space. Then if you invite a friend you are credit-
ed with an additional 500 MB of storage space. 
Above you see that the uchugeditor sent an email invita-
tion to two 'Friends' (actually my other computer, and 
my work computer!) The friend can join by downloading 
and installing the SugarSync application and you will 
have the basic 5GB plus the bonus 500MB. Your friend 

(Continued on page 19) 
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Members, if there is something you would like 
to have me put into our newsletter just let me 
know at one of our meetings or email me at: 
newsletter@lccug.com.  I would be more than 
happy to oblige you.  Pam Rihel 

will receive an email that explains the service and lets 
them link right to the site to signup. 
 

There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author. The Editorial Committee of 
the Association of Personal Computer User Groups (APCUG), an international 
organization of which this group is a member, brings this article to you. 

(Continued from page 18) Keeping it all in “Sync”... 

 

If I am in Wi-Fi, I can even make a free phone call with the 

iPod touch using a free app.  There are times I would really 

like to check my email and must wait until I am 

―connected‖… I can see the advantages 

 

My 4 and 7 year old grandchildren love the games I have in-

stalled on it for them!  They will actually amuse themselves 

for a long time with those.  Amazingly kids figure out how to 

use these games easily and love the challenge of playing 

them. 

 

There are several games on the iPod touch that I enjoy and are 

great for filling in time waiting …. 

 

Although, I have two actually eBook readers, I can read all of 

my eBooks on the touch.  I have several apps for it including 

the one for the Kindle and the Nook which allows me to read 

the same books on this smaller device.  And the reading is 

actually quite comfortable.  I prefer the Kindle reader but 

when I read on the touch it is a good experience. 

 

The iPod touch that I have (4th generation) has a camera in the 

front (for video chatting) and in the back for taking photos.  It 

actually takes a decent photo and there are a lot of apps that 

let you edit and have fun with the photos right on your device.  

It is simple to take the picture and quickly send it in an email 

or upload it to Facebook with any comments you want to in-

clude. 

 

So here is something that you can easily always have in your 

pocket or purse since it it’s the size of a Smartphone and al-

ways have with you. 

 

It has proven to be a good compromise for me until the time I 

can justify an ―always online‖ Smartphone. 

Something else to consider: 

 

I have also recently added an android tablet to my arsenal of 

gadgets and that has let me experience the Android apps and 

the advantages of a larger screen.  It is similar to the ever pop-

ular iPad but it has even more options built in.  More about 

that on another day..  

 

The presenters at the program on May 24 from Verizon 

helped explain the options available and why we would want 

to consider them.  It also sounds like there are some interest-

ing connectivity options out there that I may want to explore 

myself! 

 

It is an exciting time and things are changing fast!  A year 

from now all of this will be old news and there will be new 

options available!  We can only try to keep up! 

     

    Sandee 

(Continued from page 2) Presidents Column 
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tion, looks at all forms, from different internal combustion 

engines, to the various steam engines used now and in the 

past. Along with the visual representation, an explanation is 

given as to how it works. This site could be useful for stu-

dents and teachers alike.  

http://www.animatedengines.com 

 

Master Your Excel Worksheets 

When you open a new Microsoft Excel spreadsheet, there 

should be three worksheets available by default, labeled 

Sheet1, Sheet2, and Sheet3. As your Excel spreadsheets be-

come more complicated, it’s probably helpful to rename each 

worksheet to appropriately reflect its respective content. To 

rename a worksheet, right-click its tab and click Rename. 

Type in the new name of the worksheet and press the Enter 

key. 

 

When three worksheets aren’t enough for the job, you can add 

worksheets. To add a single worksheet, click the Insert pull-

down menu and click Worksheet. To add multiple work-

sheets, hold down Shift and select the number of worksheet 

tabs you want to add from the existing tabs. For example, if 

you want to add two new worksheets, select two current 

worksheet tabs. Finally, click Worksheet on the Insert pull-

down menu. 

 

If you have a particular worksheet you’d like to transfer or 

copy to a different workbook, select the worksheet(s) you 

want to move, click the Edit pull-down menu, and Move Or 

Copy Sheet. In the Move Or Copy dialog box, select the 

workbook you want from the To Book drop down menu and 

click OK. If you want to copy the sheet(s) instead of moving 

them, click the Create A Copy check box before you click 

OK.  

 
Reprinted with permission from Smart Computing.  Visit 

http://www.smartcomputing.com to learn what Smart Compu-
ting can do for you and your user group! 

Personalized Screen Saver  

You don't have to use the boring Windows screen saver. In-

stead, use your own folder of photos to personalize your PC. 

Copy the photos you want to use to a folder on your hard 

drive. Right-click a blank area on your Windows desktop, 

click Properties, and then click the Screen Saver tab. From the 

Screen Saver drop-down box, click My Pictures Slideshow, 

and click Browse to designate the appropriate folder of pho-

tos.  

 

In 2007, P2P activity accounted for over 30% of IPv4 traffic, 

but it now ranks fourth, with only an 8% share of the IPv4 

traffic share. Arbor Networks also reports that global P2P 

traffic is in decline.  

 

Now Serving: Your Printer  

The perfect product for a small business owner looking to 

implement a wireless network and share the company laser 

printer is a wireless router with an integrated print server. 

Such a router is marginally more expensive than a standard 

wireless router, but it lets you connect a printer (usually 

through a USB interface) for your networked PCs to share. 

And if you already have an existing wireless network, a num-

ber of companies make wireless print servers, which you can 

easily add to your network to share a printer without stringing 

wires across the room.  

 

Emails To Beware  

If you get an email urging you to update your eBay, PayPal, 

or bank account information, chances are it’s false. An easy 

way to tell in Outlook is to hover your mouse pointer over the 

hyperlink in the message. If the URL reads something like 

―www.paypal.com‖ in the message, but some other address 

such as ―www.vali-dationcgi.org‖ shows up in the floating 

box next to the pointer as you hover, you can be pretty certain 

you should delete the email.  

 

Animated Engines 
If you want to know the ins and outs of how any engine oper-

ates, check out Animated Engines . This site, through anima-
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MEMBERSHIP WITH LCCUG: 
 Yearly dues are $25 .  For more information, contact: 

 

Director of Membership, 

membership@lccug.com. 

 

Directions to Meetings: 
A map and directions to our meetings can be found on our 

Members’ web page www.lccug.com/members.  Just click 

on the link “Meeting Locations & Directions” 
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